Introduction

This application note uses the RL78/G11 25-pin E2OB board to run the demonstration application.

The hardware needed to follow this application note includes:

- Windows™ 7/ 8/ 8.1/ 10 compatible PC
- RL78/G11 25-pin E2OB board
- USB to micro USB Cable

The software components that will be obtained while following this application note include:

- e² studio (Recommended latest version)
- Renesas CCRL Embedded Compiler (Version 1.04.00)

The following documents apply to the Renesas RL78/G11 25-pin E2OB board. Please refer to the latest versions of these documents.

<table>
<thead>
<tr>
<th>Document Type</th>
<th>Description</th>
<th>Document Title</th>
<th>Available from</th>
</tr>
</thead>
</table>

Target Device

RL78/G11
### Glossary

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCRL</td>
<td>C Compiler RL</td>
</tr>
<tr>
<td>COM</td>
<td>Communications</td>
</tr>
<tr>
<td>DIP</td>
<td>Dual In-line Package</td>
</tr>
<tr>
<td>HTML</td>
<td>HyperText Markup Language</td>
</tr>
<tr>
<td>I/O</td>
<td>Input Output</td>
</tr>
<tr>
<td>LED</td>
<td>Light Emitting Diode</td>
</tr>
<tr>
<td>LPT</td>
<td>Line Printer</td>
</tr>
<tr>
<td>MCU</td>
<td>Microcontroller</td>
</tr>
<tr>
<td>OB</td>
<td>On Board</td>
</tr>
<tr>
<td>PC</td>
<td>Personal Computer</td>
</tr>
<tr>
<td>ROM</td>
<td>Read Only Memory</td>
</tr>
<tr>
<td>UART</td>
<td>Universal Asynchronous Receiver/Transmitter</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
</tbody>
</table>
Contents

Glossary .................................................................................................................................2

1. Overview .........................................................................................................................4
  1.1 Licenses .........................................................................................................................4
  1.2 Introduction ....................................................................................................................4
  1.3 Note Regarding Source Code .......................................................................................4

2. Demonstration Project Workspace ...............................................................................4
  2.1 Introduction ....................................................................................................................4
  2.2 Starting e² studio and Importing Sample Code ............................................................4
  2.3 Build Configurations and Debug Sessions ..................................................................7

3. Reviewing the Demonstration Program .......................................................................10
  3.1 Configure for Programming and Debugging ...............................................................10
  3.2 Running the Code from e² studio ................................................................................10
  3.3 Serial Communications ..............................................................................................11


5. e² studio ..........................................................................................................................17
  5.1 e² studio Installation .....................................................................................................17
  5.2 e² studio Update ..........................................................................................................19

6. Project Details ................................................................................................................21
  6.1 Project Layout ..............................................................................................................21
  6.2 Runtime Environment ..................................................................................................21

7. Installation of the Virtual Communications Port Driver .............................................22

8. Additional Information .................................................................................................25
1. Overview
This document aims to guide the user through the demonstration application for the RL78/G11 25-pin E2OB product and provides an introduction to the following features:

- Renesas microcontroller programming
- User code debugging
- User circuitry such as a switch, and LED
- Demonstration application

1.1 Licenses
This sample application does not include any third party code applications.

1.2 Introduction
This manual is designed to answer the most common questions asked about using a Renesas RL78/G11 25-pin E2OB board. The instructions help explain the following:

- How do I compile, link, download, and run a simple program on the RL78/G11 25-pin E2OB board?
- How do I build an embedded application?
- How do I use Renesas’ tools?

Files referred to in this manual are installed using the import wizard as you work through the instructions. The example in this manual assumes that installation procedures described in the RL78/G11 25-pin E2OB board Quick Start Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These instructions are designed to show you how to use the RL78/G11 25-pin E2OB board and are not intended as a comprehensive introduction to the e2 studio environment, compiler toolchains, or the E2 Lite on-board debugger. Please refer to the relevant user manuals for more in-depth information.

1.3 Note Regarding Source Code
Due to the project generator, it is possible that line numbers for source code illustrated in this document do not match exactly with that in the actual source files. It is also possible that the source address of instructions illustrated in this manual differ from those in user code compiled from the same source. These differences are minor, and do not affect the functionality of the sample code nor the validity of this manual.

2. Demonstration Project Workspace
2.1 Introduction
e2 studio is an integrated development tool that allows the user to write, compile, program and debug a software project on the RL family of Renesas microcontrollers. This application has been written as an e2 studio workspace and therefore e2 studio is required. For details on how to install e2 studio, see section 5 of this document.

This manual will describe the stages required to create and debug the supplied demonstration code.

The following instructions assume that you have downloaded the RL78/G11 demonstration program (rl78g11 Demo.zip) from the Renesas web site, and placed it in the directory C:\Renesas.

2.2 Starting e2 studio and Importing Sample Code

- Start e2 studio
  Windows™ 7: Start Menu → All Programs → Renesas Electronics e2studio → e2 studio
  Windows™ 8 / 8.1: From Apps View , click ‘e2 studio’ icon
  Windows™ 10: Start Menu → All apps → Renesas Electronics e2studio → e2 studio
The first dialog to appear will be the Workspace Launcher.

- Click ‘Browse’ and select a suitable location to store your workspace, using the ‘Create New Folder’ option as necessary. Click ‘OK’.

Note: The Workspace location does not have to contain your project files, the workspace contains the configuration of the tool and can group projects together. Projects may be referred to from this location, or the projects may be stored under this directory.

- e² studio will open with the ‘Welcome…’ tab as shown opposite.
- Close the tab by clicking on the cross.

- Right click in the ‘Project Explorer’ window and select ‘Import…’
• The Import dialog box will now show. Expand the ‘General’ folder icon, and select ‘Existing Projects into Workspace’, then click ‘Next >’.

![Import dialog box](image)

• The Import dialog box will allow you to specify a project to import. Click the ‘Browse’ button and locate the following file:

  C:/Renesas/rl78g11_demo.zip

• Press ‘OK’ and select the RL78/G11 demonstration project [rl78g11_demo]

• Click ‘Finish’.

![Import Projects dialog box](image)
2.3 Build Configurations and Debug Sessions

2.3.1 Build Configurations

The e² studio workspace will be created with two build configurations: ‘Release’ and ‘HardwareDebug’.

Release

This build mode has optimisation turned on, and provides little debug information. The C code execution may appear to be out of order, due to the way the compiler optimises the code. This build configuration is intended for final ROM-programmable code.

HardwareDebug

This default build mode has all optimisation turned off, and provides full debug information. This is the best configuration to use whilst developing programs as C code execution will be linear. The ‘HardwareDebug’ build configuration provided for this demonstration program is configured to load the code directly into ROM.

2.3.2 Building the code

- Click the top level ‘rl78g11_demo’ folder again, and then the arrow next to the build button (hammer icon), and select the ‘HardwareDebug’ option. e² studio will now build the code.
- The output from the build process will be presented in the console window of e² studio.

2.3.3 Debug Configuration

Click the arrow next to the debug button (bug icon). Select ‘Debug Configurations…’.

- The ‘Debug Configurations’ dialog box will appear. Click on the expand icon next to ‘Renesas GDB Hardware Debugging’ to expand the view.
- By default, e² studio creates Debug Configurations for each existing build mode. The rl78g11_demo project has pre-configured debug configurations that are ready to use.

Note:

To manually create a new e² studio debug configuration, click on ‘Renesas GDB Hardware Debugging’ then click on the ‘New’ button (top left).
• Select ‘rl78g11_demo HardwareDebug’

• The debug configurations control page will open. Observe the settings under each tab.

• Under the ‘Debugger’ tab, ensure the ‘Debugger hardware’ option is set to ‘E2 Lite (RL78)’.

• The ‘Target Device’ is preset to ‘R5F1058A’.

• Under the ‘Debugger’ tab, ‘Connection Settings’ sub-tab ensure that ‘Power Target From The Emulator’ is set to ‘No’.

Note:
Do not modify any settings.

• Select the ‘Startup’ tab.

• Ensure the ‘Runtime Option’ ‘Set breakpoint at’ is specified as ‘main’.

• Ensure that the DIP switches on the board are set as indicated below:
• Click on ‘Debug’.

• Before downloading the code a dialog box will appear asking if you would like to switch to the ‘e² studio Debug perspective’. If you agree click ‘Remember my decision’ to prevent this dialog box from appearing in future, then click ‘Yes’.

• e² studio will load the new perspective, which is optimised for debugging.

• To change back to the default ‘C/C++’ perspective, from the menu bar select Window ➔ Perspective ➔ Open Perspective ➔ Other

• The ‘Open Perspective’ dialog box will appear. Click on the desired perspective to select it then ‘OK’.

• Alternatively, click on the button within the top right corner of the screen, as shown opposite, and select the ‘C/C++’ perspective.
3. **Reviewing the Demonstration Program**

This section will show how to run the demonstration program code and use basic debugging functionality in e² studio.

### 3.1 Configure for Programming and Debugging

Before plugging the USB connector into the board, configure the switches for programming and debugging as shown in Figure 1 below:

![Figure 1 Switch Settings for Programming / Debugging](image)

Then plug the micro USB connector into the board and the other end into a USB port on your PC. The board should power up, and the green LED between the DIP switches and the USB connector should flash on and off to indicate that the E2 On Board debugger is running, and waiting for a connection to e² studio.

### 3.2 Running the Code from e² studio

Launch e² studio. If you have not already done so, import the sample code as described in section 2.2.

Next, build the code by pressing the hammer button 🛠️, or by right-clicking on the project and selecting ‘Build Project’. The project will take just a few seconds to build.

Now click on the debug button ▶️ to run the program. The green LED will stop flashing and will be permanently on to indicate that the debugger is now connected.

The red LED will flicker during programming and debugging operations.

The code will start to run, but will then stop at a breakpoint in the ‘cstart.asm’ assembler file as shown to the right.
Press the resume button or F8. The program will run and then stop again at a breakpoint on the first line in main().

You can now step through the program using the debugger buttons or function keys.

Press the resume button again to continue running the program.

The green user LED will now flash on and off at a rate of around 5Hz.

Press the user switch. The LED should flash twice as fast while the switch is held down.

3.3 Serial Communications

Press the Terminate button (or press CTRL F2) to terminate the program. Please wait for a few seconds until ‘Disconnected from the Target Debugger’ is displayed on the console before unplugging the USB connector from the board.

Note: It is important to wait until the debugger has disconnected before removing power from the board, otherwise the program may not run properly when powered up without the debugger running.

With the micro USB connector unplugged from the board, change the DIP switches as shown in Figure 2 below:

![Figure 2 Switch Settings for Serial Communications](image)

Note: It is always necessary to power down the board before making changes to the DIP switch settings.

The board is now configured to relay serial communications from the PC via the USB connector to the RL78/G11 MCU. Because of this, it is not possible to run the debugger at the same time. Plug the board back in.

Note: Windows 7 users will need to install a virtual COM port driver. Please refer to section 7 for full instructions.

Open Windows Device Manager and expand ‘Ports (COM and LPT)’ to determine which COM port has been allocated to the device. In the case shown on the right, Windows has allocated COM4.
Run a serial console program on the PC, for example PuTTY or Tera Term, and configure the serial communications for 9600 baud, 8 data bits, 1 stop bit and no parity.

With the board plugged back in, the red LED should be on, and the green user LED next to it flashing on and off.

Type ‘help’ on the console. The response should look like this:

![Figure 3 Help Command Console Output](image)

Enter the command ‘LED 10’. The terminal should respond with ‘OK’, and the LED will flash more slowly (at approximately 1Hz). See figure 4 below:

![Figure 4 LED Command Console Output](image)

Enter the command ‘SWITCH’. The console will respond with the current state of the switch. See below:

![Figure 5 SWITCH Command Console Output](image)
4. Quick Guide to Creating a New RL78/G11 Project

This section gives instructions on how to create a new project from scratch using the Code Generator to generate code for peripherals in the MCU.

In e2 studio select File → New → C Project:

Enter a name for your project and under Project name and choose Executable (Renesas) → Sample Project and Renesas CCRL Toolchain.

Click ‘Next’.
In the Select Target Specific Settings dialog select the Toolchain version (usually the most recent one), E2 Lite (RL78) for the Debug Hardware, and (for the RL78/G11 25-pin) R5F1058A for Select Target.

Under Select Configurations check Hardware Debug and Release (no debug).

Click ‘Next >’.

The Code Generator simplifies the process of creating initialisation and peripheral driver boiler plate code. Check Use Peripheral code Generator in the next dialog box to enable it:

Click ‘Finish’.
Finally click ‘OK’ in the summary dialog box:

Using the Code Generator is fairly self-explanatory, although it is worth noting that the peripheral menu is hidden in the top right-hand corner. The menu is shown when the triangle (below) is clicked.

After changing peripheral settings, save them and then click ‘Generate Code’ to generate the code from the chosen configuration. The generated code appears in the src/cg_src folder. Settings can be modified at a later time and the code regenerated. User code that is placed in the files produced by the Code Generator will be untouched, as long as it is placed between the comments where specified. An example of this is shown below. The two lines of code between the comments will not be affected if ‘Generate Code’ is run again.

```c
/* Start user code. Do not edit comment generated here */
g_commanded_led_rate = 1;
led_counter = 0;
/* End user code. Do not edit comment generated here */
```

Right-click on the project and select ‘Renesas Tool Settings’. Select Compiler → Optimization, and then set ‘Level of optimization’ to ‘Debug Precedence’.
Click ‘OK’.

The project can now be built.
5. e² studio

The Quick Start Guide will have directed you to install e² studio. This section gives detailed instructions on how to do this.

If e² studio is already installed, please follow section 5.2. For first time installation please follow the procedure described in section 5.1.

Section 5.1 gives instructions on installing e² studio version 5.4. It is recommended to use the latest version of e² studio as available on the web site.

5.1 e² studio Installation

1. The latest e² studio installer can be acquired from the Renesas website at https://www.renesas.com/en-eu/products/software-tools/tools/ide/e2studio.html

2. Once downloaded, double click on the application. A message box will ask if you want to install Renesas e² studio (note the version number in the dialog will change). Click ‘Yes’.

3. Once fully extracted, the e² studio installation wizard will guide you through the installation process. On the ‘Welcome’ tab click ‘Next >’.

4. In the ‘Install Folder’ page, enter the desired folder path for the root location of e² studio. The default path is recommended. To continue click ‘Next >’.
5. In the ‘Device Families’ page, ensure that the RL78 family has been selected. It may also be desired to select support for other devices. Once selected, click ‘Next >’.  

6. In the ‘Extra Components’ page you can select support needed for your development requirements. To continue click ‘Next >’.  

7. The ‘Components’ page will give the option to install optional components. It is recommended that all are selected, then click ‘Next >’.  

8. In the ‘Additional Software’ tab, ensure that ‘Renesas CCRL v1.04.00’ is selected. Click ‘Next >’.  

9. In the ‘Licenses’ page ensure to read and accept the Software Agreement to continue. Click ‘Install’.  

10. The ‘Summary’ page will give an overview of the components of the installation. Click ‘Install’ to start the installation process.  

11. Once the installation process has finished click ‘OK’.  
To open e2 studio please follow the instructions below.

- Start e2 studio
  - Windows™ 7: Start Menu → All Programs → Renesas Electronics e2studio → e2 studio
  - Windows™ 10: Start Menu → All apps → Renesas Electronics e2studio → e2 studio
• In the ‘Select a workspace’ dialog box, browse to a suitable location and enter a folder name to save your new workspace. Click ‘OK’ to continue.
• On the ‘There are no new toolchains available for integration’ message box, click ‘OK’.
• In the e² studio ‘Welcome’ screen, click the ‘Go to the workbench’ arrow icon, on the far right.
• The Code Generator Registration message box will ask to register code generator. Click ‘OK’.
• Once registered, another message box will ask you to restart e² studio. Click ‘OK’. e² studio will restart.

5.2 e² studio Update

To update the tools integrated with e² studio, or to add new tools, use the following procedure:

1. Select Help → Install New Software… from the menu, followed by selecting the link below in the ‘Work with’ box.

   [Insert hyperlink]

2. For the example of updating the RL78 family support select the ‘Renesas RL78 Family Support’ in the list of available software and click ‘Next >’.

3. Installation details will then be shown. Click ‘Next >’.

4. Read the ‘License text’ and select ‘I accept the terms of the license agreement’ to continue.
A message box will then ask you to restart e2 studio. Click ‘Yes’.

5. Once restarted the installation process is complete.
6. Project Details

This section details the sample project layout and components used.

6.1 Project Layout

The project layout as shown in e² studio is as below:

The following folders contain useful or user modifiable contents:

- **doc**: HTML files summarising code produced by the Code Generator
- **HardwareDebug**: When built, stores the build files for the debug configuration
- **Release**: When built, stores the build files for release configuration
- **src**: Source code for project. All user modifiable code is located in this sub-folder

The layout of the src folder is as follows:

<table>
<thead>
<tr>
<th>Name</th>
<th>Overview</th>
</tr>
</thead>
<tbody>
<tr>
<td>cg_src</td>
<td>Source files produced by the Code Generator</td>
</tr>
<tr>
<td>cstart.asm</td>
<td>Initialisation and start up code (assembler)</td>
</tr>
<tr>
<td>iodfne.h</td>
<td>I/O definitions</td>
</tr>
<tr>
<td>stkinit.asm</td>
<td>Stack initialisation (assembler)</td>
</tr>
<tr>
<td>command.c</td>
<td>The command interpreter source file</td>
</tr>
<tr>
<td>command.h</td>
<td>The command interpreter header file</td>
</tr>
</tbody>
</table>

6.2 Runtime Environment

The following resources are used in the application:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Device</th>
<th>Function/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8-bit Interval timer</td>
<td>Channels 0 &amp; 1</td>
<td>16-bit counter mode used for the delay when flashing the LED</td>
</tr>
<tr>
<td>Serial Array Unit</td>
<td>UART1</td>
<td>Used for the command interface serial I/O</td>
</tr>
</tbody>
</table>
7. Installation of the Virtual Communications Port Driver

Windows 7/8 users will need to install the Renesas Virtual Communications Port Driver to interact with the demonstration software via a serial console application. Follow the instructions below to install this driver.

1) Download the driver files (RL78G11_CDC_Demo.inf and rl78g11_cdc_demo.cat) from https://www.renesas.com/products/RL78G11RPBdemonstration
2) Plug the RL78/G11 25-pin with E2OB into a USB port. Windows will fail to find a driver.
3) Open Windows Device Manager and expand ‘Other devices’:

![Device Manager]

4) Right click ‘RENESAS E2OB Serial Port’, and select ‘Update Driver Software…’ from the menu:

![Update Driver Software]
5) On the ‘Update Driver Software - Renesas E2OB Serial Port; How do you want to search for driver software?’ dialog box select ‘Browse my computer for driver software’:

6) In the ‘Update Driver Software - Renesas E2OB Serial Port; Browse for driver software on your computer’ dialog box, browse to the location of the downloaded driver files, and then select the ‘Next’ button:

7) On the ‘Windows Security’ dialog box select ‘Install’:

8) Select ‘Close’ on the ‘Windows has successfully updated your driver software’ dialog box:
9) Windows **Device Manager** should now show that Windows has allocated a COM port for the virtual communications port (COM5 in the example below):
8. Additional Information

Technical Support

For details on how to use e² studio, refer to the help file by opening e² studio, then selecting Help → Help Contents from the menu bar.

For information about the RL series microcontrollers refer to the RL Group Hardware Manual.

Technical Contact Details

Please refer to the contact details listed in section 4 of the RL78/G11 ‘Quick Start Guide’ (r01qs0010eg0100-rl78g11.pdf).

Renesas Electronics Website:
  https://www.renesas.com/

Inquiries:
  https://www.renesas.com/contact/

This product’s homepage, where additional documentation and source code can be found, is located at:
## Revision History

<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date</th>
<th>Page</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>July 12, 2017</td>
<td>All</td>
<td>Original release</td>
</tr>
</tbody>
</table>

All trademarks and registered trademarks are the property of their respective owners.
General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Handling of Unused Pins
   Handle unused pins in accordance with the directions given under Handling of Unused Pins in the manual.
   — The input pins of CMOS products are generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal become possible. Unused pins should be handled as described under Handling of Unused Pins in the manual.

2. Processing at Power-on
   The state of the product is undefined at the moment when power is supplied.
   — The states of internal circuits in the LSI are indeterminate and the states of register settings and pins are undefined at the moment when power is supplied.
   In a finished product where the reset signal is applied to the external reset pin, the states of pins are not guaranteed from the moment when power is supplied until the reset process is completed.
   In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the moment when power is supplied until the power reaches the level at which resetting has been specified.

3. Prohibition of Access to Reserved Addresses
   Access to reserved addresses is prohibited.
   — The reserved addresses are provided for the possible future expansion of functions. Do not access these addresses; the correct operation of LSI is not guaranteed if they are accessed.

4. Clock Signals
   After applying a reset, only release the reset line after the operating clock signal has become stable. When switching the clock signal during program execution, wait until the target clock signal has stabilized.
   — When the clock signal is generated with an external resonator (or from an external oscillator) during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Moreover, when switching to a clock signal produced with an external resonator (or by an external oscillator) while program execution is in progress, wait until the target clock signal is stable.

5. Differences between Products
   Before changing from one product to another, i.e. to a product with a different part number, confirm that the change will not lead to problems.
   — The characteristics of Microprocessing unit or Microcontroller unit products in the same group but having a different part number may differ in terms of the internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-evaluation test for the given product.
1. Descriptions of circuits, software, and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other disputes involving patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawing, chart, program, algorithm, application examples.

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall not alter, modify, copy or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copy or otherwise misappropriation of Renesas Electronics products.

5. Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality." The intended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.

   Standard: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots etc.

   High Quality: Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may cause serious property damages (space and underwater repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment etc.). Renesas Electronics disclaims any and all liability for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas Electronics.

6. When using the Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes). “General Notes for Handling and Using Semiconductors” in the reliability handbook, etc., and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operation power supply voltage range, heat radiation characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions or failure or accident arising out of the use of Renesas Electronics products beyond such specified ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please ensure to implement safety measures to guard them against the possibility of bodily injury, injury or damage caused by fire, and social damage in the event of failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures by your own responsibility as warranty for your products/system. Because the evaluation of microcomputer software alone is very difficult and not practical, please evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. Please investigate applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the RoHS Directive carefully and sufficiently and use Renesas Electronics products in compliance with all applicable laws and regulations.

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall not use Renesas Electronics products or technologies for (1) any purpose relating to the development, design, manufacture, use, stockpiling, etc., of weapons of mass destruction, such as nuclear weapons, chemical weapons, or biological weapons, or missiles (including unmanned aerial vehicles (UAVs)) for delivering such weapons, (2) any purpose relating to the development, design, manufacture, or use of conventional weapons, or (3) any other purpose of disturbing international peace and security, and you shall not sell, export, lease, transfer, or release Renesas Electronics products or technologies to any third party whether directly or indirectly with knowledge or reason to know that the third party or any other party will engage in the activities described above. When exporting, selling, transferring, etc., Renesas Electronics products or technologies, you shall comply with any applicable export control laws and regulations promulgated and administered by the governments of the countries asserting jurisdiction over the parties or transactions.

10. Please acknowledge and agree that you shall bear all the losses and damages which are incurred from the misuse or violation of the terms and conditions described in this document, including this notice, and hold Renesas Electronics harmless, if such misuse or violation results from your resale or making Renesas Electronics products available any third party.

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products. (Note 1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries. (Note 2) "Renesas Electronics product" means any product developed or manufactured by or for Renesas Electronics.

Rev. 3.0-1 November 2016

SALES OFFICES

Renesas Electronics Corporation

Renesas Electronics America Inc.
2801 Scott Boulevard Santa Clara, CA 95050-2549, U.S.A.
Tel: +1-408-588-6000, Fax: +1-408-588-6136

Renesas Electronics Canada Limited
9251 Yonge Street, Suite 8305 Richmond Hill, Ontario Canada L4C 9T3
Tel: 905-237-2004

Renesas Electronics Europe Limited
Dukes Meadow, Witheard Road, Bourne End, Buckinghamshire, SL8 5FH, UK
Tel: +44-1628-585-100, Fax: +44-1628-585-900

Renesas Electronics Europe GmbH
Amadlastrasse 10, 40472 Düsseldorf, Germany
Tel: +49-211-6503-0, Fax: +49-211-6503-1327

Renesas Electronics (China) Co., Ltd.
Room 1709, Quantum Plaza, No.27, Zhuchunlu, Haidian District, Beijing 100191, P.R.China
Tel: +86-10-8235-1100, Fax: +86-10-8235-7879

Renesas Electronics (Shanghai) Co., Ltd.
Unit 301, Tower A, Central Times, 555 Lianao Road, Pudus District, Shanghai, P. R. China 200033
Tel: +86-21-2226-0888, Fax: +86-21-2226-6999

Renesas Electronics Hong Kong Limited
Unit 1601-1611, 16/F., Tower 2, Grand Century Place, 193 Prince Edward Road West, Mongkok, Kowloon, Hong Kong
Tel: +852-2266-6688, Fax: +852-2286-9022

Renesas Electronics Taiwan Co., Ltd.
13F, No. 363, Fu Shing North Road, Tapi 10543, Taiwan
Tel: +886-2-8175-9600, Fax: +886-2-8175-9670

Renesas Electronics Singapore Pte. Ltd.
81 Bendemeer Road, Unit 06-02 Hyflux Innovation Centre, Singapore 339949
Tel: +65-6213-0201, Fax: +65-6213-0300

Renesas Electronics Malaysia Sdn.Bhd.
Unit 1207, Block B, Menara Amcorp, Amcorp Trade Centre, No. 18, Jln Persiaran Barat, 46050 Petaling Jaya, Selangor Darul Ehsan, Malaysia
Tel: +603-795-6390, Fax: +603-7955-9911

Renesas Electronics India Pvt. Ltd.
No.777C, 100 Feet Road, HAL II Stage, Indiranagar, Bangalore, India
Tel: +91-80-67208700, Fax: +91-80-67208777

Renesas Electronics Korea Co., Ltd.
12F., 234 Teheran-ro, Gangnam-Gu, Seoul, 135-080, Korea
Tel: +82-2-556-3737, Fax: +82-2-556-5141

© 2017 Renesas Electronics Corporation. All rights reserved.

Colophon 6.0

Notice

Referto "http://www.renesas.com/" for the latest and detailed information.